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Manufacturer:   Cambridge Sensotec Limited 
     Unit 29 Stephenson Road 

St Ives 
CAMBS 
PE27 3WJ, England 

 
Product Names:   Rapidox 3100 OEM oxygen analyser 
 
Model Numbers:   RX3100 OEM 
 
Conform to the following specifications: 
 
EMC:  EN 61326:1998 Electrical equipment for measurement,  
     control and laboratory use 
 

Declaration: I declare that the above products conform to the applicable 
requirements of the LVD Directive 73/23/EEC and the EMC Directive 89/336/EEC 
and is CE marked accordingly. 
 

Signature:     
 
Name:    Dr. Mark Swetnam 
 
Title:     Managing Director 
 
Company:    Cambridge Sensotec Limited 
 
Date:     4th May 2009 

 
WEEE Regulations 2006 

 
Cambridge Sensotec takes its responsibilities under the WEEE 
Regulations extremely seriously and has taken steps to be compliant line 
with our corporate and social responsibilities.   In the UK, Cambridge 
Sensotec has joined a registered compliance scheme “WeeeCare” 
(WeeeCare registration number WEE/MP3538PZ/SCH). 

 
UK users only:  If you have purchased any electronic or electrical product from 
Cambridge Sensotec since 2007 and would like to dispose of it correctly under the 
WEEE scheme, please contact us and we will be happy to either arrange the 
collection of the waste or have it returned to our offices for recycling.  All our in-
house manufactured products are scheme compliant and carry the WEEE label 
indicating that it is NOT allowed to be disposed of in a landfill site. 

http://www.weeecare.com/
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1. Introduction 

 
The Rapidox 3100 OEM oxygen analyser allows fast and accurate oxygen analysis 
over the full oxygen range (10-20ppm to 100% O2) using three independent sensor 
channels.  The Rapidox provides continuous on-line oxygen analysis, with a 
typical response time of less than 4 seconds for a 90% response to a step change in 
gas compositions. 
 
The sensor head (three supplied) comprises a zirconia ceramic tube, which is 
heated up to 650°C in order for it to conduct oxygen ions.  Power for the sensor 
heater is supplied and accurately controlled by a regulated power supply 
incorporated in the analyser. 
 
The analyser is packed with features including programmable alarm circuits, 
programmable analogue outputs, easy calibration (user selectable gases), RS485 
communications and complete communications / data logging software. 
 

2. Features 
 

 Three independent sensor channels 
 

 Very fast measurement response (typically 1-4 seconds for a 90% response). 
 

 Full measurement range available (10-20ppm to 100% O2). 
 

 Accuracy ± 1% of the actual measured oxygen with a precision of ± 0.5%. 
 

 Easy calibration procedure requiring any two or three gas mixtures (air is 
usually one). 
 

 Simple installation, low maintenance, sensor life expectancy typically 17,500 
hours. 
 

 Bespoke software with LCD display emulator 
 

 RS485, 0-5V and 4-20mA analogue outputs (both programmable). 
 

 Fully programmable alarm circuits. 
 

 Full data logging software 
 

 Password protection 
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3. Specification 
 

3.1 Rapidox 3100 OEM Dimensions 

 

Case dimensions: W=350mm; D=263mm; H=150mm.  Weight=5.5kg.  Runs off 
any worldwide voltage of 90-260VAC 50/60Hz. 
 

3.2 Accuracy and Precision 

  
Sensor response time is typically 4 seconds for a 90% response involving a step 
change in composition.  A change between 21% and 100% can be recorded in less 
than 4 seconds depending on flow rates.  High accuracy is maintained between 
calibration points.  Accuracy is 1% of the actual measured oxygen content with a 
precision of 0.5%.  Outside the calibration range accuracy is typically 2.5%. 
 

3.3 Display 

 
The OEM unit does not have a display fitted to the instrument case.  The sensor 
readings are obtained using the bespoke software that communicates via the 
RS485 (connected through an Easy-Sync adapter supplied).  The on-screen display 
shows an LCD emulator that reproduces exactly the LCD fitted to the bench 
analysers. 
 

3.4 Sensor Head 

 

The sensor head consists of a zirconia 'Nernstian' cell housed in a metal case with 
an 18mm 1.5mm pitch thread for tapping into pipes and flues.  It operates at 
pressures between 10-4 Torr and 50 bar positive pressure.  The sensor is heated to 
approximately 650oC using a platinum resistance heater.  This temperature is 
controlled by the Rapidox unit which gives enhanced stability to the calibration.   
 
Sensor body external length: 66mm.   
Projection into the gas stream: 28.2mm.   
Cable length: 2m.   
Sensor life expectancy: typically 17,500 hours in clean gases. 
 

3.5 Calibration 

 
The simple and fully flexible calibration procedure requires two calibration gases 
(ambient air 20.95% is normally used as calibration gas no. 1 – labelled “Gas 1”).  
The calibration gas compositions are user-selectable and programmed into the 
Rapidox via the software menu.  Factory pre-sets can be reloaded to allow the unit 
to be 'rescued' from a failed calibration. 
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3.6 Operating Temperature 

 
Gas temperature must not exceed 650oC and should ideally be kept below 350oC 
for optimum performance.  Sensor cables must not exceed 100°C for extended 
periods, or 300oC for more than 15 seconds.  The Rapidox unit’s normal operating 
temperature is 5-35oC. 
 

3.7 Outputs 

 
The RS485 serial port outputs on demand values for oxygen (ppm),time 
(hh:mm:ss) and date (dd/mm/yy).  This data can be downloaded and logged using 
the software provided. 
 
Standard 0-5V and 4-20mA analogue outputs are available on the rear panel for 
O2, as are normally-open or normally closed reed relay O2 alarm signals.  These 
outputs are fully user-programmable via the software provided. 
 

4. Technical Specification 
 

4.1 Rapidox Analyser 

 

Property Specification 
Supply Voltage 90-260VAC, 50/60Hz 
Power consumption 300W (max) 
Analyser dimensions W350mm X D263mm X H150mm 
Weight 5.5 kg 
Display On-screen LCD display emulator 
Warm up time 3-4 minutes at 20°C 
Operating heater voltage 13-15V 
Normal operating temperature 5-35°C 
Outputs: O2  0-5V (user-programmable) into minimum 

5k 
 O2 4-20mA current loop (user-programmable) 

into maximum 500 
  High and low alarms Relay contacts – fully user-programmable 
  All data and parameters RS485 - data streamed on demand 

Calibration 
Requires 2 user-selectable gas 
compositions (air is default plus another 
two) for each sensor in turn 
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4.2 Rapidox Sensor 

 

Property Specification 
Cable 2-4m high temperature silicone sheathed 

cable, fully shielded.  Nickel quick release 
plug 

Max sustained gas temperature  650°C 
Temperature of metal housing 150 to 200°C  
Life expectancy > 17,500 hours 
Range of measurement 10-20ppm to 100% O2 
Response time (@ gas flow rate 1l.min-1) Approximately 4 secs for a 90% step 

change (e.g., from 21% to 100% O2) 
Accuracy ± 1% of the actual oxygen concentration 
Precision of measurement ± 0.5% of the reading 
Maximum working pressure 50 bar (depends on gas and temperature) 

200 bar burst pressure 
Minimum working pressure Vacuum tight down to below 10-4 Torr 

 

5. Precautions 
 
Make sure you read and understand these instructions and keep them safe for later 
use.  The unit should not be exposed to extreme temperatures < -5°C or > 60°C.  
Normal operating temperature is 5-35°C.  Avoid direct sunlight.  Do not use liquid 
cleaners, aerosols or solvents to clean the case.  Use a damp cloth for cleaning.  Do 
not use this equipment near water.  Make sure the rear ventilation slots and the 
fan on the rear panel are free of obstruction. 
 
There are no user serviceable parts in this unit.  Do not attempt to repair yourself.  
Refer all servicing to qualified Cambridge Sensotec personnel. 
 

6. Warning 
 
The sensor head and metal surroundings become hot (>100°C) during use and 
careful consideration should be taken to avoid the risk of burn injury. 
 
This unit is NOT designed for use in life support situations.  No responsibility can 
be held for injury or loss of life caused by inappropriate use of this equipment. 
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7. Rapidox Operating Instructions 
 

7.1 Sensor Location 

 
The three sensor heads (see Figure 1) comprise a small tube of high purity 
zirconia, which becomes an oxygen conductor when heated to approximately 
650oC (see Figure 2).  The ceramic can be damaged if the sensor head is knocked 
or dropped, so care must be taken when handling it. 
 
Select a suitable location for each sensor bearing in mind that the temperature of 
the measurement gas must be less than 650°C and ideally below 350°C where the 
sensor tip is located.  The outer part of the sensor must be in ambient air.  
Cambridge Sensotec can supply a selection of sensor housings (see Figure 3) to 
allow access in awkward situations, and if necessary a small pump can be 
installed to sample the gas remotely. 
 

 

Figure 1: The zirconia oxygen sensor 

 

 
 

Figure 2: Oxygen sensor schematic, 1 = zirconia electrolyte, 2 = electrodes, 3 = 
contact, 4 = housing, 5 = sample pipe, 6 = ceramic protective coating (porous) 
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M5 clearanace
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Top View

Side View

1/8" BSP tapered
thread (or NPT)

Figure 3: Schematic showing sensor attached to gas pipe adapter (supplied).  Gas flows across 
the sensor via pipes attached to the nipple fittings. 

 
As with all electronic devices, the Rapidox sensor signal may be affected by strong 
electromagnetic noise interference although this has been minimised by careful 
shielding.  Please ensure that wherever possible, the sensor head and analyser are 
kept away from sources of electrical noise.  Ensure that the sensor cable is not 
touching any hot surfaces and is kept away from areas that are generating 
electrical noise.  The cable is designed to withstand temperatures of up to 150oC 
for short periods (<15 seconds). 
 
The sensor is threaded with an 18mm 1.5mm pitch thread, which is a standard tap 
size for automotive spark-plugs.  Ensure that the sensor is tightened down 
securely so that no gas can escape around the thread.  A selection of gaskets is 
available for different applications (e.g. working above pressures of 1 bar or under 
vacuum conditions). 
 
The sample chamber is tapped with a 1/8” BSP tapered thread.  NPT fittings will 
also fit this tap. 
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7.2 The Rapidox Analyser - Front and Rear Panels 

 

 

Figure 4: Rapidox 3100 OEM front panel.  Numbers are referred to in the text. 

 

 

Figure 5: Rapidox 3100 OEM rear panel.  Numbers are referred to in the text 

 

8. Getting Started 
 

Ensure that the Rapidox OEM analyser is located away from extreme heat and dirt 
environments.  Plug the unit in to a suitable supply (noting the information on the 
serial sticker and using the power cable supplied) using the rear power socket (5).  
Make sure that the cooling fan (6) is not obstructed during operation.  Connect the 
three sensor plugs to the rear of the Rapidox using the 5-way Cannon type socket 
(2).  Note that the sensors are factory calibrated to a particular channel and 
labelled accordingly.  Connect the easy-Sync unit to the rear serial socket (3) and 
make sure the OEM software is correctly installed and the communications cable 
is attached to a USB port. 
 
Turn the unit on using the red power switch on the front (1).  At this point start 

1 

2 

3 

4 

5 

6 
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the OEM software (see section 9 for a full description) and establish 
communications with the unit.  The on-screen LCD is available from the 
“Utilities” menu and should be enabled.  The display will display the firmware 
version and serial number followed by the message “HEATING SENSOR”.  The 
three sensors will take approximately four minutes to come up to temperature, 
after which the Rapidox will begin to take measurements.  The progress of the 
sensor heater is shown in the form of a bar graph on the LCD display.  Once at 
temperature the LCD display will show the oxygen readings of all three sensors at 
once.  The lower right hand corner of the LCD will display the range selected 
(H=high, M=Medium & L=Low).  The symbol ALARM  may appear to the bottom 
right of the LCD if the alarm system is enabled and an alarm condition applies. 
 
Allow thirty minutes for the box to stabilise fully.  This allows the components of 
the analyser to reach a stable working temperature.  During this warm-up period it 
is common for the baseline oxygen to drift by a small amount, which may be 
corrected by re-calibrating. 
 

8.1 Menu Access / Passwords 

 

The analyser has an option to set a password that will restrict access to the 
software menus.  The password menu is disabled by default in the factory.  If you 
wish to password protect the analyser follow the software instructions in section 
9. 
 
If the password has been forgotten please contact Cambridge Sensotec who will 
advise you on how to recover it. 
 

8.2 Rapidox Calibration 

 

The Rapidox OEM is calibrated using the software supplied.  Please see section 9.7 
for details of the calibration procedure.  Below are some guidelines for performing 
a successful calibration. 

Care must be taken to calibrate the analyser so that, whenever possible, the range 
of measurement lies between the two calibration points.  For example, if you are 
working at 10ppm but have calibrated the analyser between 21% and 100% then 
the analyser will be inaccurate.  You would need to calibrate at, say, 1ppm and 
21% to be sure of good accuracy.   The procedure is as follows:  

1)               Bearing in mind the points made above decide which two gases you are 
going to use for calibration.  If you are constantly working at a particular 
range of compositions then it would be wise to obtain small cylinders of 
calibration gas with analysis certificates.  You may need to programme the 
analyser and tell it which two gases you are using.  This procedure is 
necessary only when you change calibration gases and the cal gas values 
are entered into the appropriate boxes on the config 2 page of the software. 



Cambridge Sensotec Rapidox 3100 OEM Oxygen Analyser Instruction Manual 
 

 

 
 
Version 3.4 9 Last printed 17/11/2011 10:22:00 
 

2)               The sensor needs to be exposed to the first calibration gas from a cylinder 
(or exposed to ambient air, 20.95% if this is the calibration gas of choice).  
Allow several minutes to pass to flush the sensor chamber properly and 
make sure that the flow rate over the sensor is the same as when it is in use 
(0.5-4 litres per minute is recommended).  Wait for the top line of the on-
screen LCD display to become stable.  To complete the calibration click on 
the button labelled "Calibrate O2 with gas 1".  The display will now 
correctly read the value of the first calibration gas.    

4)               To calibrate against the second calibration gas, repeat the procedure from 2 
but this time flush the sensor chamber with the second calibration gas 
allowing several minutes for the new gas to flush through, and as before, 
use the same flow rate as in use (0.5-4 litres per minute is recommended).  
Wait for the display to become stable before clicking on the button labelled 
"Calibrate O2 with gas 2".  The analyser will then recalibrate and then return 
to normal run mode.  The display will now correctly read the value of the 
second calibration gas. 

5)               The analyser is now correctly calibrated and will read accurately between 
these two calibration points.  Note that this procedure must be performed 
for each separate channel in turn. 

6)               If at any time, you encounter difficulties and wish to restore the machine to 
its factory set calibration, use the configuration software provided and load 
the default settings.  Each machine and channel is provided with a unique 
file that contains the factory settings.  This is located on the CD-Rom 
provided and is copied onto your PC during the installation process. 

 NB You must always perform a FULL calibration to achieve good accuracy.  

 

8.3 Cleaning the Sensor 

 

You can clean each of the three sensors at any time by using the software 
described in section 9.7.  Note that only the selected channel is cleaned.  The 
procedure takes approximately five seconds and the on-screen LCD display shows 
the progress of the operation.  Once finished, the analyser will take a few seconds 
to re-stabilise.  The sensor is cleaned each time the unit is switched on prior to 
operation.  If you are operating in gases with large amounts of soot, there is a risk 
that the sensor surfaces will become contaminated with particulates, which will 
impair performance if allowed to build up.  The cleaning operation pumps oxygen 
through the zirconia tube, which burns the particulates away from the sensor 
surface. 
 

8.4 Oxygen Range 

 

The Rapidox 3100 OEM has three oxygen measurement ranges which can be 
programmed using the software provided (section 9.5.1).  Always select the most 
appropriate range in order to achieve maximum resolution from the analyser.  The 
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three ranges are labelled HIGH, MEDIUM & LOW.  
 

1. High  from 0.1% to 100% oxygen 
2. Medium from 1ppm to 100% oxygen 
3. Low  from 10-20ppm to 100% oxygen 

 
The range currently in use is displayed in the bottom right hand corner of the LCD 
display by the character L, M or H.  To change the range select option 3 “Set O2 
Range” and press ENT.  Use the UP & DOWN arrows to select the required range 
and press ENT to finish.  If the measurement is out of range then please select a 
different range to continue operating. 
 

8.5 Alarms 

 

The Rapidox is fitted with two independent and fully programmable alarm relay 
outputs, whose set-points can be programmed as well as enabling the alarm relay 
circuits, enabling an audible buzzer and enabling a visual warning on the screen. 
 
The alarm circuit relays are accessed via the terminal blocks (4) on the rear panel 
and are clearly labelled.  Alarm High is assigned to the terminals labelled “Alarm 
1” and Alarm Low is assigned to the terminals labelled “Alarm 2”.  The relay 
circuit is rated at 24V 0.5amps maximum. 
 
The alarm limits for oxygen are set to a minimum of 10-20ppm and a maximum of 
1000%.  At any time, should a sensor become disconnected so there is a fault 
condition then the Rapidox will set the alarm channel to OFF to prevent false 
alarms. 
 

8.6 Analogue Outputs 

 
The Rapidox analyser provides various analogue outputs.  The standard industrial 
analogue outputs (0-5V and 4-20mA) for oxygen are accessible via the terminal 
blocks (4) on the rear panel.  These outputs have a 12 bit resolution 
(approximately 1 in 4000) and the lower and upper values are fully user-
programmable using the software provided (section 9). Three output mode options 
are provided for setting the outputs, in order to give the user maximum flexibility: 
 

1. LIN (ppm):  The linear oxygen output mode setting produces an output that is 
scaled linearly between 0 and 5V (or 4 and 20mA).  So, for example, if the 
scale is set 0V = 0% O2 and 5V = 100% O2 then 2.5V would indicate an 
oxygen reading of 50% O2.  The scaling of this example is shown in the 
following plot, from which other intermediate values can also be read.  This 
setting is more suitable for medium to high ranges of oxygen, or where the user 
wishes to monitor oxygen over a narrow range. 
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Figure 6: Graph showing the linear output mode option for oxygen 

The following general formulae can be used to calculate the oxygen from the 
voltage or current outputs when set to the linear output mode: 
 

Output type Formula for calculating oxygen from analogue output signal 

0-5V O2 = Vout / 5 * (O2H - O2L) + O2L 

4-20mA O2 = (mAout – 4) / 16 * (O2H - O2L) + O2L 

 
Where:  O2L = user setting of oxygen for 0V or 4mA output 1 

O2H = user setting of oxygen for 5V or 20mA output 1 
Vout = the measured voltage output in volts 
mAout = the measured current output in mA 

1 O2, O2L and O2H must all be in the same units. 

 
2. LOG (ppm):  This setting produces an output that is scaled logarithmically 

between 0V and 5V (or 4 and 20mA).  So, for example, if the scale is set to 0V 
= 0.0001% (1 ppm) and 5V = 100% (1000000 ppm) then 2.5V would indicate 
an oxygen reading of 0.1% (1000 ppm).  This scale is more suitable for large 
ranges of oxygen down to very low ppm levels.  Note that because the scaling 

is logarithmic 0V cannot be set to 0% oxygen since log(0) is -∞!  The lowest 
permitted setting is 0V = 10-20 ppm (or 10-24 %) O2.  The scaling of this example 
is shown in the blue line in following plot, from which other intermediate 
values can also be read.  For comparison, the red line shows the limitations of 
using the linear oxygen output mode over the same range. 
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Figure 7: Graph showing the logarithmic output mode option for oxygen (blue) compared with 
linear mode (red). 

 
The following general formulae can be used to calculate the oxygen from the 
voltage or current outputs when set to the log output mode: 
 

Output type Formula for calculating log10(O2) from analogue output signal 

0-5V log10(O2) = Vout / 5 * log10(O2H / O2L) + log10(O2L) 

4-20mA log10(O2) = (mAout – 4) / 16 * log10(O2H / O2L) + log10(O2L) 
 
Where:  O2L = user setting of oxygen for 0V or 4mA output 2 

O2H = user setting of oxygen for 5V or 20mA output 2 
Vout = the measured voltage output in volts 
mAout = the measured current output in mA 

2 O2, O2L and O2H must all be in the same units. 

Note: O2 = 10 log(O2) 

 
3. RAW (mV):  This setting is for certain customers who like to monitor the raw 

sensor EMF signal.  The signal from a sensor goes from approximately -50mV 
at 100% O2 through zero at approx 5% O2 and to +1000mV at extremely low O2 
levels.  So, for example, if the scale is set to 0V (output) = -50mV (sensor 
voltage at approximately 100% O2) and 5V (output) = 250mV (sensor voltage at 
approximately 1ppm O2) then 2.5V would indicate a sensor voltage of 100mV.  
The scaling of this example is shown in the following plot, from which other 
intermediate values can also be read. 
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Figure 8: Graph showing the raw sensor mV output mode option for oxygen 

 
The following general formulae can be used to calculate the oxygen sensor raw 
voltage (O2mV) from the voltage or current outputs when set to the raw sensor 
voltage output mode: 
 

Output type Formula for calculating sensor mV from analogue output signal 

0-5V O2mV = Vout / 5 * (O2mVH - O2mVL) + O2mVL 

4-20mA O2mV = (mAout – 4) / 16 * (O2mVH - O2mVL) + O2mVL 
 
Where:  O2mVL = user setting of oxygen mV for 0V or 4mA output  

O2mVH = user setting of oxygen mV for 5V or 20mA output  
Vout = the measured voltage output in volts 
mAout = the measured current output in mA 

 
Note that the terminals labelled “Auxilary” on the rear panel (4) are NOT 
connected in the OEM version and should be ignored. 
 
Note that the voltage (0 to 5V) and current (4 to 20mA) outputs are locked 
together, so that these outputs cannot be set independently of each other.  In 
normal operation therefore, 0V output always corresponds to 4mA and 5V always 
corresponds to 20mA output. 
 
During initial warm up of the Rapidox when the display reads “Sensor Heating” 
the output sent to the rear terminal for oxygen will stay at 2mA (0.628V) which is 
the standby signal.  The output for the temperature or pressure sensor will begin 
to work after the initial boot up screen. 
 
If at any stage a sensor becomes disconnected (externally or internally) or the 
signal exceeds the measurable range for that sensor, then the display will indicate 
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there is a fault and the outputs will change to 1mA (0.313V) which is the sensor 
fault signal.  This will recover as soon as the sensor is reconnected and the fault 
cleared. 
 

8.7 Display Units 

 
The notation used by the display is fully programmable to suit your needs using 
the software provided.  The oxygen reading can be displayed in percent (e.g. 
20.95%), ppm (e.g. 0.01ppm) or scientific (e.g. 2.095E+05ppm).  If percent is 
selected the Rapidox will display oxygen as a percentage down to 0.1% and ppm 
below this value.  At values less than 1ppm the display switches to scientific 
notation for the remainder of the range.  There is also an option to display the 
oxygen reading in terms of a pressure. 
 

8.8 LCD Refresh rate 

 

The user can select the LCD refresh rate using the the software provided.  The 
frequency of the display update can be selected from 0.1 to 1.5 seconds. 
 

8.9 Setting Date & Time 

 
The date and time can be programmed using the software “Utilities” menu and 
selecting “Set Date & Time”.  Note that if you re-programme the date & time it will 
use the current date and time of the PC. 
 
Note that the exact date format will depend on the country you are in and the 
language and local settings of the PC which you have used to connect to the 
analyser.  So for example in the USA you would now see the date as mm/dd/yy.  
The local date format will be stored along with the date and time in the Rapidox. 
 

8.10 RS485 Port 

 

The serial port (3) on the rear of the OEM unit has been factory set to RS485.  Data 
from each of the sensors is sent in turn, on demand to the socket on the rear panel 
and can be read using a simple terminal programme such as 'HyperTerminal' in 
Windows, or with the user's own custom software.  However the OEM analyser 
has been designed to run exclusively with the software included.  This includes a 
simple and convenient data logger programme and is described in section 10 
below. 
 

8.11 Load Defaults 

 

If you make a mistake programming the Rapidox it is possible to restore the 
machine back to its factory settings by loading the unique default configuration 
that is supplied on your software CD-ROM.  The default set-up can only be 
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accessed using the software provided.  Please see section 9.4 for further details. 
 

9. Rapidox Software Instructions 
 

9.1 Software Installation 

 
It is possible to the Rapidox OEM using an RS485 link with a PC running MS-
Windows (all versions) and the supplied Rapidox OEM software.  The software is 
installed automatically by inserting the Rapidox CD into the CD-ROM drive.  If 
auto-installation does not start then you can click the Windows START button 
and select RUN.  Type X:\setup.exe where X is the drive letter of your CD.  
Alternatively access the CD from Windows Explorer or the ‘My Computer’ icon on 
your desktop, and double-click on the ‘Setup.exe’ programme.  Follow the on-
screen instructions to install the programme onto the hard drive.  Once installed, 
you can access the programme by clicking START - PROGRAMS – Rapidox 
Software. 
 
The software has been tested successfully on most language machines including 
Chinese, Korean & Japanese and all current versions of Windows operating 
system.  We do not recommend the use of Vista as connecting devices to this 
operating system can be problematical at best. 
 
Note that software is ‘regionally aware’ and will therefore accept and display data 
using the decimal separator that is set in the PC’s Regional Settings in the Control 
Panel.  For example, in the UK or US, you might enter the value 2.5 - in 
continental Europe this would normally be entered as 2,5 assuming the PC’s 
Regional Settings have been set up to use ‘,’ as the decimal separator. 
 

9.2 Getting Started 

 

Please note that you MUST use the "Easy Snc Adapter" provided or the software 
will not work correctly! 

Make sure that the Rapidox is connected to a free serial port on the rear of your 
computer.  These will nearly always be COM1 or COM2 but the software will scan 
through the ports until it finds the Rapidox.  The analyser must be switched on for 
this to succeed and while you are communicating with it.  On start up the 
software will locate the Rapidox and display the following page.  The values 
displayed in the columns of boxes above the ‘Read’ and ‘Write’ buttons may differ 
from those shown.  NOT ALL features are available with this model. 
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Figure 9: Configuration 1 page.  Note the actual values used may differ from those shown above. 

 

The yellow status box at the bottom will display confirmation that the Rapidox 
was found and the result of the last action, or any error messages if there is a 
problem with communication.  If you experience problems check that your serial 
cable (supplied) is correctly fitted to a valid USB port, and that you do not have 
another application open that may be using the same port.  There are several types 
of serial cable available.  You must use the cable and Easy-Sync adapter as 
supplied as other cable formats will not work.  Also check the status of your COM 
port settings in Device Manager accessed by clicking START – Settings - Control 
Panel. 
 

9.3 On-Screen Help 

 
You can access the on-screen help facility at any time by clicking on the ‘Help’ 
menu on the menu bar and select the ‘Help’ option or press F1. 
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9.4 Configuration Pages 

 

The configuration page is split into two (see figures 11 & 12) and you can toggle by 
clicking on the folder tabs labelled “config 1” and “config 2” page allows the user 
to reprogram an array of variables used by the Rapidox.  Once written to the 
Rapidox, the new variables remain permanent until overwritten. 
 

As this is a multi-channel analyser the channel of choice must be selected first 
using the drop-down box at the bottom of the window labelled "Sensor board 
selected" (see figure 11).  In this example Sensor 1 is selected and all the 
parameters on config 1 & 2 pages now refer to this sensor only.  Note that the label 
"Sensor 1" can be edited by the user in the LCD display window.   

To read the current configuration for the selected board stored in your Rapidox 
select ‘Read Analyser Configuration’ from the file menu.  Note that the edit boxes 
on the RHS will turn red if the value is different to that just read and a red asterisk 
will appear next to the ‘Write’ button to warn you that a change has been made.  
The left-hand set of grey text fields (‘read fields’) will be updated with the current 
configuration data.  To save this information (e.g. if several people share the same 
instrument) press the long copy button to transfer the data into the edit boxes, 
select ‘Save Configuration as’ from the file menu and choose a filename.  This data 
set can be subsequently be reloaded at any time by selecting ‘Load Configuration 
File’ button and selecting the directory where the configuration files have been 
stored.  

If at any time you wish to restore the machine to its factory default settings select 
‘Default Configuration’ from the file menu to load these values.  The software will 
search for a unique rxc file that is loaded onto the PC during the software 
installation.  The filename is 2100***.rxc where *** is the last three digits of the 
serial number located on the rear of the machine.  This file is also located on the 
CD-Rom that came with the machine.  Normally this file is located in the main 
Rapidox directory but if the software can not locate it then it will ask you for the 
serial number to help it search.  With the correct rxc file loaded simply press 
COPY to transfer the defaults into the edit boxes and then select WRITE to load 
them back into the Rapidox.  

The right-hand set of white editable text fields (‘write fields’) is used to enter new 
values to be programmed into the Rapidox.  The values in these fields can either 
be entered manually, or copied across from the ‘read fields’ by clicking the vertical 
‘Copy’ button, and then edited as required.  Alternatively, you can load saved 
configuration data by selecting ‘Load Configuration’ from the file menu and 
selecting the required file.  In order to programme the analyser select ‘Write 
configuration to the analyser’ from the file menu.  
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9.5 Reconfiguring the Analyser 

 

The on-screen edit boxes contain variables that can be reprogrammed into the 
Rapidox.  For a full description please refer to the relevant section in this manual.  

The user can choose whether to use ppm or percent notation to edit the text boxes 
by selecting the UNITS menu and clicking on percent or ppm.  To access a field, 
either click inside it or use the TAB key to scroll through them.  Note that some 
parameters are greyed out - these options are NOT applicable for the OEM version 
of the Rapidox. The field parameters are as follows:  

9.5.1 Config 1 Screen 

 

1)                 Oxygen Range:   

       The Rapidox OEM is fitted with three ranges of oxygen which can be 
programmed using the software provided.  Always select the most 
appropriate range to work with to achieve maximum resolution from the 
analyser.  The three ranges are labelled LOW, MEDIUM & HIGH. Note that 
if you operate the machine below the minimum value of a particular range 
the display will ‘bottom out’ and you need to select a lower range to 
continue measuring. 

           High            from 0.1% to 100% oxygen 
           Medium       from 0.001% to 100% oxygen 
           Low            from 10-20ppm to 100% oxygen 

           The range currently in use is displayed in the bottom right hand corner of 
the LCD display by the character L, M or H.   

2)              Oxygen Units:  Use the drop down box to select PPM EXPONENTIAL, PPM 
MIXED, AUTO%/PPM or PRESSURE.  The default setting is AUTO%/PPM.   
The oxygen reading can be displayed in percent (e.g. 20.95%), ppm (e.g. 
0.01ppm) or scientific (e.g. 2.095E+05ppm).  There is also an option to 
display the oxygen reading in terms of a pressure in mbar.  If percent is 
selected the Rapidox will display oxygen as a percentage down to 0.1% and 
ppm below this value.  At values less than 1ppm the display switches to 
scientific notation for the remainder of the range 

3)              Temperature Units: Not available for the OEM version 

4)              Pressure Units: Not available for the OEM version 

5)              Pressure Correction Mode:  Not available for the OEM version 

6)              Operating Mode:  Not available for the OEM version 

7)              Auxiliary Output Parameter: Not available for the OEM version 
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8)             Alarm Outputs:  Use the drop down menu to select OFF or ON.  When set 
to ON the alarm circuits on the rear are activated.  The default setting is 
OFF.  The Rapidox is fitted with fully programmable alarms.  There are two 
independent alarm circuits for low and high oxygen conditions.  These are 
relay circuits which are open if there is no alarm and closed when an alarm 
condition occurs.  You have the option of enabling the alarm circuits, 
enabling an audible buzzer and enabling a visual warning on the screen.  
Note that the alarm circuit relays are accessed via the terminal block on the 
rear panel and are clearly labelled.  The relay circuit is rated at 24V 
0.5amps maximum. 

9)               Audible Alarm:  Use the drop down menu to select OFF or ON.  When set 
to ON the buzzer will sound when an alarm is activated.  The default 
setting is OFF. 

10)          Visible Alarm:  Use the drop down menu to select OFF or ON.  When set to 
ON the on-screen LCD display will show the word ALARM (flashing) when 
an alarm is activated.  The default setting is OFF. 

11)      LCD Refresh interval:  Use the drop down menu to select a refresh rate for 
the on-screen LCD (min 0.1, max 1.5 sec).  The default is 0.3 seconds. 

12)      Oxygen Analogue Output Mode: The Rapidox analyser provides three 
analogue outputs for oxygen: LIN, LOG & RAW.  Please see section 3.7 for a 
complete description.  The standard industrial analogue outputs (0-5V and 
4-20mA) are accessible via the terminal block (4) on the rear panel.  These 
outputs have a 12 bit resolution (approximately 1 in 4000) and the lower 
and upper values are fully user-programmable.  

13)          Password option:  The analyser has an option to set a password that will 
restrict access to the menus.  The password menu is disabled by default in 
the factory.  If you wish to password protect the analyser select "enable" 
from the drop down menu.  Click the "write" button to activate.  The 
software will ask you for the default password which is “0000” as shown in 
figure 5: 

   

Figure 10:  Password entry screen.  Please note that the factory default is 0000 

Once the password has been entered successfully the Rapidox will be 
programmed with your command.  The same procedure applies if you want 
to disable the password function.   The other option is to RESET the 
password to a new value.  The password must be 4 digits long and can be 
any combination of numbers from 0000-9999.  Make sure that the new 
password is noted down!  If the password function has been enabled then 
in the future each time the software is accessed then the password prompt 
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will display.  After the correct password is entered then all the software 
functions become accessible.   If the password has been forgotten please 
contact Cambridge Sensotec who will advise you on how to recover it.  
Note that you will be prompted to enter the original password if you wish 
to make changes to the password or its status. 

9.5.2 Config 2 Screen 

  

Figure 11: Configuration 2 screen. Note the actual values used may differ from those shown 
above.  

14)           Calibration Gas 1:  Use this box to enter a new value for the first cal gas.  
The value can be entered either in % or ppm depending on the units 
selected.  The default is %.  Enter a value such as 10.1 for 10.1%The default 
value for cal gas 1 is 20.95% 

15)           Calibration Gas 2:  Use this box to enter a new value for the second cal 
gas.  The value can be entered either in % or ppm depending on the units 
selected.  The default is %.  Enter a value such as 0.1 for 0.1%  The default 
value for cal gas 2 is 0.001% (10ppm). 

16)           Calibration Constant A & B:  These boxes contain the calibration 
constants that the Rapidox calculates automatically when you perform a 
calibration.  You will see that they change each time you perform a new 
calibration.  It is possible to manually edit these but this should only be 
attempted after consulting with Cambridge Sensotec.  Normally they are 
just provided for information and should be left untouched.  The default 
settings are A= -46.482 and B= -38.845.  Note that the values are always 
negative as this follows the convention of the Nernst equation. 

17)           High & Low Alarm Thresholds:  Use these two boxes to enter new values 
for the alarm trigger points.  The alarm High value must always be greater 
than the alarm low value.  The value can be entered either in % or ppm 
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depending on the units selected.  The default is %.  Enter a value such as 
10.1 for 10.1%.  The default values are 25% for Alarm High and 0.001% for 
Alarm Low. 

18)           Analogue Output (0V/4mA & 5V/20mA):  Use these four boxes to set the 
High and Low oxygen for the analogue outputs on the rear panel of the 
analyser.  For example if you want 4mA to represent 1% and 20mA to 
represent 21% then enter these two values into the appropriate boxes.  The 
value can be entered either in % or ppm depending on the units selected.  
The default is %.  The default values are 25% for the high setting and 
0.001% for the low setting. 

19)           Gas 1 & Gas 2 emf (mV):  These values are for information purposes only 
and cannot be adjusted.  They represent the voltage that the Rapidox 
measured on the sensor at the point of calibration.  These values are used in 
the calculation of the A & B values derived from the Nernst equation.  As a 
guide the emf in air is around -8mV and the value at 10ppm is around 
+190mV.  Exact values depend entirely on the individual sensor. 

20)            Oxygen and helium impedance setting:  These values are for information 
purposes only and can not be adjusted.  They control the temperature of the 
heater for the two modes of operation by setting the impedance of the 
zirconia cell to a pre-determined value. 

Once you have finished editing the parameters, select ‘Write Configuration to 
Analyser’ from the file menu or click the ‘Write’ button on any configuration page 
and the new data set will be written to the Rapidox.  The Rapidox is 
reprogrammed using the new configuration.  The software then reads the new 
settings back from the Rapidox and displays them in the boxes on the left-hand 
side confirming that the configuration was successful.  

 

9.6 On-Screen LCD 

 

It is possible to display an LCD emulator on the desktop of your PC.  This shows 
ALL THREE channels on the OEM unit together.  The top line of each display 
shows the oxygen value and the second line is reserved for showing the ALARM 
status and oxygen range (L, M or H).  To activate the LCD select the utilities menu 
and select the LCD on option.  This will display a small window showing the LCD 
that can be positioned independently anywhere on the desktop. 
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Figure 12: On-screen LCD.  Values shown are for illustrative purposes only. 

 

The blue LED indicator will flash to show that the display is updating.  To close 
the LCD either click its window close button, or click the ‘Utilities’ menu on the 
main programme window and select the ‘Hide LCD’ option.   
  
The active channel (set on the config 1 page) is shown slightly highlighted as in 
Figure 9 (channel 2 is shown active).  To change the active channel you can 
double click on the LCD with the mouse and it will update itself.  You can also 
rename each channel if required.  For example click on the text labelled "Sensor 1" 
and change to "Hot Zone".  The new channel label is stored when the software is 
closed and also updates both on the config 1 page and the graph legend (see 
section on data-logging). 
 

9.7 Remote Calibrating 

 

With the on-screen LCD display active it is possible to remotely calibrate the 
analyser and clean the sensor.  Click on the down arrow icon in the bottom right-
hand corner of the LCD display to expand the window: 
 

 

Figure 13: Remote calibration and clean function. Values shown are for illustrative purposes 
only. 
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Use the three buttons to calibrate or clean the sensor directly from the PC.  Before 
calibrating the analyser with gas, make sure that you know the exact O2 
concentration in your gas bottle AND you have a calibration certificate from the 
gas supplier confirming the concentration.  You can calibrate the analyser in any 
order but remember that the gas value for O2 Gas 1 must be greater than the gas 
value for O2 Gas 2.  Allow sufficient time for the calibration gas to pass over the 
sensor and let the reading on the LCD stabilise.  This is extremely important to 
perform a successful and accurate calibration.  

The software uses the two calibration gas values already stored in the Rapidox as a 
starting point (see config 2 page instructions for changing the cal gas values).  
These are typically High = 20.95%, and Low = 0.001% as set in the factory but 
may be different if the user has recalibrated with other gas values in the past.  
Either way you are given an option to change the cal gas value before proceeding 
to the actual calibration.  

Assuming you are using fresh air (20.95%) to calibrate O2 High then simply click 
on the button labelled “Calibrate O2 with gas 1” to see the following: 

 

Figure 14: Calibration Gas Confirmation Screen. 

If the current stored value is correct and matches your cal gas value then simply 
click “Yes” to proceed.  If you are using a different value to the one you see on the 
screen then click “No” to return to the main menu and change it as described in 
9.5.2. 

This is your final chance to change your mind before committing to a calibration.  
Check carefully that the gas value on the screen actually matches the value of your 
calibration gas before clicking on “Yes” to complete the calibration.  At this point 
you should observe that the LCD display will reset itself to the correct calibration.  
You can now proceed with the rest of the calibration process by selecting the gas 2 
in the same manner. 

 

9.8 Cleaning the Sensors 

 

You can clean the sensors at any time by pressing the button labelled "Clean 
Sensor".  The procedure takes approximately five seconds and the LCD display 
shows the progress of the operation.  Once finished the analyser will take a 
moment to re-stabilise.  The sensors are cleaned each time the unit is switched on 
prior to operation.  If you are operating in gases with large amounts of soot, there 
is a risk that the sensor surfaces will become contaminated with particulates, 
which will impair performance if allowed to build up.  The cleaning operation 
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pumps oxygen through the zirconia tube, which burns the particulates away from 
the sensor surface. 

 

9.9 Software Utilities 

 

The utilities menu is located on the main file menu as shown below: 
 

 

Figure 15:  Software Utilities Menu 

9.9.1 Setting Analyser Date and Time 

 
The current date and time of your PC are displayed on the configuration screen 
and can be loaded into the Rapidox by selecting the Utilities menu and clicking 
the ‘Set date and time’ option.  This information is used in the RS232 data string 
for data logging purposes.  Make sure that your PC clock is set correctly before 
using this function, as you cannot edit the date and time shown by the Rapidox 
software.  The date and time formats displayed are those set in the PC’s Regional 
Settings. 
 

9.9.2 Check for Updates 

 

This function will check online and advise you if any software updates are 
available for your machine.  This function is not automatic.  To update the 
software you need to visit www.cambridge-sensotec.co.uk and select the support 
page where a list of downloads are provided. 
 

9.9.3 Image Grabber 
 

This is a simple function to allow the user to copy the software screens into the 
Windows clipboard.  This is useful for diagnosing problems; allowing a quick and 
simple way of sending the Sensotec technicians actual screen shots of the 
software.  To recover the images simply press CTL+V to paste. 

http://www.cambridge-sensotec.co.uk/
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10. Rapidox Data Logging Software 
 

10.1 Introduction 

 
The Rapidox software includes a full data logging facility which logs data from 
ALL THREE channels simultaneously.  Data can be saved to a file automatically at 
regular intervals and the format is compatible with modern spreadsheet 
programmes such as MS-Excel.  A live-time graphing facility is also included 
which has many powerful features.  Note that the data logging facility will only 
function if the analyser is in NORMAL run mode.  
 

10.2 Setting up the Data Logger 

 
Click on the tab labelled ‘Data Acquisition’ to display the following page: 
 

  

Figure 16: Data Logging page 

 
During logging, data from the analyser is shown in the central area of this page.  
The data is displayed in the following columns: time (in seconds), channel 1 O2 
value (in ppm and mV), channel 2 O2 value (in ppm and mV), channel 3 O2 value 
(in ppm and mV), time (H:M:S), date (dd/mm/yyyy), status of channels 1,2,&3 
(L=Low, M=Medium, H=High, Alarm), 
  
To start data logging select the frequency of measurement by entering a time and 
selecting a unit from the drop down list.  For example if you wish to log data once 
every minute type 1 in the box and select ‘Minutes’ from the drop down menu.  
The fastest speed the three channel OEM analyser can log at is 1 second. 
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You can open the notes window at any time by selecting NOTES from the ‘Data 
Logger’ drop down menu.  A small text box appears in which you can type a text 
message.  This note is then saved as a header in the data file set and can be viewed 
along with the data. 
  
You can either choose to have data logged continuously until ‘Stop’ is selected 
from the Data Logger menu, or you can choose to set a time limit for data logging 
by checking the box labelled ‘Time Limit’, setting the duration in the ‘Run For’ box 
and selecting units with the drop down list.  For example if you wish to log data 
for thirty minutes type ‘30’ in the box and select ‘Minutes’ from the drop down 
list. 
 

10.3 Running the Data Logger 

 
If you wish to save the data into a file for later use, check the ‘Save to File’ box 
before selecting ‘Run’ from the ‘Data Logger’ menu.  You will be prompted for a 
file name and location before data logging commences.  The file and path 
information will appear in the box at the top of the page labelled ‘Data File Name’.  
If you forget to select file saving before starting a run, you will nevertheless be 
prompted at the end as to whether you wish to save the run data. 
 
The blue progress bar displays the state of completion of the run, and the blue box 
to the right of it displays the same information as a percentage.  You can stop the 
run at any time by selecting ‘Stop’ from the ‘Data Logger’ menu.  The yellow Status 
bar at the bottom of the page gives information about the data logging operation. 
 
Once data logging is complete you may open the text format data file using any 
compatible spreadsheet programme such as MS-Excel, and use the data to 
generate plots and reports.  You can save files with a “.txt” extension (the factory 
default) or a “.csv” extension, and whichever was last used will become the new 
default.  See section 10.20 “Working with Spreadsheets” for more on this topic. 
 
You can pause the data logger at any time by selecting ‘Data logger’ and ‘Pause’.  
Click ‘Data logger’, ‘Resume’ to continue logging from where you left off, noting 
that the clock keeps ticking during the pause period. 
 

10.4 Auto Date Stamped Files 

 

If you are planning to run the data logger for extended periods of time then you 
should consider checking the ‘Auto date stamped file’ option.  This feature will 
save the data at midnight for the previous twenty four hours and so on until the 
data logging is complete OR the user interrupts it.  The data file is stored with a 
date suffix in brackets in yy-mm-dd format. 
 
This feature ensures that data is saved periodically in sensible sized files.  This 
will prevent the computer from crashing and will also ensure that the data is small 
enough to fit into an MS-Excel spreadsheet 
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As an example, the user wishes to run the data logger for seven days recording 
every minute starting at lunchtime on 12th November 2005.  He starts the data 
logger with the auto-date stamp function enabled.  When prompted he gives the 
filename as “test1.txt”.  In this situation the data logger will run from lunchtime to 
midnight and then save the first file as “test1 (2005-11-12).txt”.  The data logger 
then clears and continues for another twenty four hours until midnight the 
following day.  The data is then stored as “test1 (2005-11-13).txt”.  This will 
continue for seven days when the data logger will finish. 
 
After this the user will have a sequence of files: 
 
test1 (2005-11-12).txt 
test1 (2005-11-13).txt 
test1 (2005-11-14).txt 
 
And so on.  Combined together they represent all the data over the last seven days.  
Note that the Rapidox uses the computer clock and date to perform this action, so 
make sure that they are correct before starting a run. 
 
To view the data in its entirety the user would need to load each file in turn back 
into e.g., MS-Excel to combine them. 
 

10.5 Live-Time Graphing Screen 

 

The Rapidox data logging package includes a live-time graphing facility that 
allows you to monitor the progress of your data in a graphical format (see Figure 
17).  To access the graph check the box labelled ‘Show Graph’.  The graph will 
appear in a new window, and can be accessed at any time without disturbing a 
run that is already in progress.  You can select  ‘Run’ and ‘Stop’ from the ‘Data 
Logger’ menu in the graphing window to begin and end data logging, and the 
window can be minimised to (and restored from) the task bar while logging data.   
 
To close the window and return to the main data logging page select ‘Close Plot’ 
from the ‘File’ menu or click on the close window button. 
 
The features of the graph window are described below: 



Cambridge Sensotec Rapidox 3100 OEM Oxygen Analyser Instruction Manual 
 

 

 
 
Version 3.4 28 Last printed 17/11/2011 10:22:00 
 

 

 

 

Figure 17:  Live-time graphing screen 

 

10.6 Main Graph Window 

 

The graph is an XY plot, with time plotted on the X-axis and the three oxygen 
channels plotted on the Y-axis.  The X-axis is auto-scale during data logging so 
that all data points are shown on the graph at all times. 

 

10.7 Plot Colours 

 

The default colours used on the graph are set to blue for sensor 1, red for sensor 2 
and green for sensor 3.  To change the colours double-click on the coloured label 
at the bottom of the graph window.  A colour palette window will appear (see 
Figure 18) and a new colour can either be chosen from a colour box, or for more 
variety, by clicking the ‘Define Custom Colors >>’ button.  Click on ‘OK’ to select 
the new colour or ‘Cancel’ to return to the graph without change. 
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Figure 18: Plot colour palette menu accessed by double-clicking on the axes titles. 

 

10.8 Graph Titles and Labels 

 

If you want to change the text of the graph axis labels, place the mouse pointer 
over the text and do a single left click to enter edit mode.  The text can then be 
modified.  Similarly, to change the title of the graph, place the mouse pointer over 
the title and click once to edit.  If you choose not to enter a title the graph will 
display the path and filename of the run as the new title once the run has 
finished.  Note that these changes are only temporary and will be overwritten by 
the defaults if a new run is started or the graph window is closed and reopened.  
They are provided so that the plot may be printed with alternative labels. 
 

10.9 Plot Co-ordinates 

 

The box labelled ‘Plot co-ordinates’ to the upper left of the graph window displays 
the actual plot co-ordinate value at the mouse pointer.  This can be used to get a 
quick oxygen value from the graph.  Simply place the mouse pointer at a place of 
interest and read the corresponding X1 and Y1 values in the box. 
 

10.10 Last data point 

 

During data acquisition, the box labelled ‘Last data point’ will appear at the upper 
middle of the graph window.  It displays the last data values read from the 
analyser. 
 

10.11 Using the Cursor 

 

Clicking and holding the left mouse button with the pointer over the ‘C’ at the top 
of the plot area activates the cursor, which appears as a vertical dashed line on the 
plot. While keeping the mouse button pressed, you can now move the pointer 
anywhere in the plot area or on the ‘C’ in order to move the cursor.  The box 
labelled ‘Cursor’ to the upper right of the graph window will display actual values 
for oxygen, time and the data point number (n) at or immediately to the left of the 
cursor position.  The cursor can be used to investigate actual data values at 
specific points of interest on the graph. 
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10.12 Zooming 

 
You can zoom in to any part of the oxygen plot by simply placing the mouse 
pointer on the new graph start position and then clicking and dragging a new box 
to re-size the graph.  The label on the box to the upper left of the graph window 
will change to ‘Zoom box co-ordinates’, and an extra set of co-ordinates, labelled 
X2 and Y2, will appear, showing the co-ordinates in X and Y units of the second 
corner of the zoom rectangle as you drag the mouse pointer.  The plot will zoom 
and auto-scale when you release the mouse button.  This can be repeated if you 
wish to zoom in even further.  To zoom back to the original size select ‘Zoom Full’ 
from the ‘View’ menu. 
 
Note that although you can use the zoom facility during a live run, the graph will 
auto-scale to full size with each new data point. 
 

10.13 Y-Axis Graph Units 

 
You can toggle the Y1 oxygen units at any time from percent to ppm and vice 
versa.  Select ‘O2 Units’ from the ‘View’ menu and choose either percent or ppm.  
The current selection is then displayed in the top right box labelled ‘O2 Axis’. 
 

10.14 Oxygen Scale 

 
You can display the Y1 oxygen axis in linear or logarithmic format at any time by 
selecting ‘O2 Scale’ from the ‘View’ menu. The current selection is then displayed 
in the top right box labelled ‘O2 Axis’.  Note that the zoom function is disabled 
when you are viewing on a log scale. 
 

10.15 Loading an Old Run 

 
A previously logged data file can be loaded and viewed by selecting ‘Open Data 
File’ from the ‘File’ menu and selecting the appropriate TXT or CSV file.  A 
progress bar is displayed while the data is being imported.  Note that very large 
data files may take several seconds to load.  The data is re-graphed and you can 
zoom, label axes, change colours etc., before printing the graph. 
 

10.16 Printing Graphs 

 
You can print the graph at any time by selecting ‘Print Plot’ from the ‘File’ menu.  
This will bring up the printer dialogue box for your specific printer where you can 
choose various printing options.  Make sure that the printer page is set to 
landscape to obtain a full size print out. 
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10.17 Data Logging in the Background 

 
It is possible to begin data logging and then minimise the windows in order to 
continue working with another application.  To minimise the graph simply click 
on the minimise button on the blue title bar at the top of the window.  You can 
then use the ALT + TAB keys to take you to other programmes already running.  
To return to the graph simply maximise from the start menu bar or press ALT + 
TAB again.  If the graph does not redraw immediately select ‘Zoom Full’ from the 
‘View’ menu to redraw. 
 

10.18 Pausing the Data Logging 

 

You can pause the data logging at any time during the run by selecting the ‘Data 
Logger’ menu and selecting ‘Pause’.  Repeat the action to continue, noting that the 
live graph will draw a straight line between the paused points to keep continuity 
of the axes.  The clock keeps ticking during the pause period. 
 
If you decide to access the menu of the Rapidox using the front keypad during 
data logging, then the software will pause automatically.  A message appears on 
the screen informing the user that the unit is being accessed from the keypad.  
Once the menu has been exited, the software will continue data logging from 
where it left off.  The clock keeps ticking during the pause period. 
 

10.19 Changing the Data Logging Parameters Mid-run 

 

Once the data logging has begun it is not possible to modify the original total 
length of time that the data logging will run for, but you may change the sample 
interval time by pausing the data logger and then entering a new value for the time 
interval.  The data logger can then be resumed with the new values in place.  Note 
that you can not change units (e.g. seconds to hours) once logging has started.  If 
you originally selected seconds then you may change the current value to a new 
value between 1 and 3600 seconds, if you originally selected minutes then you 
may change between 0.02 and 360 and if you selected hours you may change 
between 0.01 and 6 hours.  You can of course stop the run at any time using the 
‘Data Logger’, ‘Stop’ menu option. 
 

10.20 Working with Spreadsheets 

 
The data logger saves data files in a standard comma separated ASCII text format 
which can be readily imported into spreadsheet programmes such as MS-Excel, in 
order to produce plots and reports as desired.  For specific information on how to 
import text files into your spreadsheet programme please refer to the help guide 
supplied with the programme. 
 
Data is saved in comma separated value format, with a ‘.txt’ file extension as the 
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initial programme default.  However, when entering the file name, you can instead 
select a ‘.csv’ extension: the programme will register the last used file extension as 
the new default.  The ‘.csv’ extension is recognised by MS-Excel, so that opening 
the file will automatically run MS-Excel, and this may be of benefit if your 
regional decimal separator is period ‘.’ rather than comma ‘,’.  However, if your 
decimal separator is comma, you should continue to use the ‘.txt’ extension and 
open the file explicitly from within your spreadsheet programme, defining the 
field delimiter as ‘comma’ where appropriate. 
 

10.21 Disaster Recovery 

 
To prevent catastrophic loss of important data during a computer crash or power 
failure, the data is automatically saved point by point in a temporary file called 
‘Rapidox temporary data file 2100xxx.txt’, where 2100xxx is the serial number of 
your Rapidox.  This file is located in the same directory as the main Rapidox 
programme itself and can be renamed or copied to recover data that would 
otherwise be lost.  Note that this file is overwritten each time ‘Run’ is selected 
from the ‘Data Logger’ menu so make sure all data is recovered successfully before 
starting another run. 
 
Note that during a run using the ‘auto date stamped’ feature, the temporary data 
file is wiped clean as soon as the previous data set has been saved successfully.  In 
the case of a crash the temporary data file should be used to recover the last day’s 
worth of data that was not saved to the hard disc. 
 

10.22 Diagnostics 

 

The Rapidox software includes a diagnostics page that is accessed from the tab 
labelled ‘Diagnostics’.  This screen will display various values and settings that are 
operating inside your machine.  There is no editing possible on this page – it is 
purely for information and to enable technical support help you should you 
experience difficulties with your machine.  You may be asked to record values 
from this page if trouble shooting is required. 

Note that the information found on the diagnostics page refers to the active 
channel only.  To view diagnostic data from a different channel go to the LCD 
display and click on the channel of interest to activate it.  The display will appear 
brighter than the non-active other two. 
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Figure 19: Rapidox Diagnostics Page  

1. Analogue:  The live analogue values displayed in this pane are voltage 
measurements coming directly from the computer chip inside the analyser.  
They are for information purposes only but are a useful diagnostics tool for 
Sensotec staff, as unusual values can indicate a particular fault.  To help 
Sensotec diagnose a fault please capture this window as shown above using 
the screen capture function described in section 9.9 above and e-mail it to 
support@cambridge-sensotec.co.uk 
  

2. Sensor State:  These boxes should all indicate “OK” on a healthy analyser.  
Note that the Rapidox 1100Z does not have a temperature sensor fitted so 
all references to temperature on this screen are not relevant.  The possible 
messages are “OK” “High” “Low” or “Fault”.  The High and Low messages 
indicate that the sensor is out off normal range.  The fault message will only 
display if the sensor is disconnected or has failed in some way. 
  

3. Digital:  The digital signals coming directly from the computer chip inside 
the analyser can be monitored here.  To test the keypad is working correctly 
try pushing the buttons and watching the panel.  A correctly functioning 
key will turn the box red on the screen and the digital value for that 
particular key will show in the data box.  If the analyser has an external 
thermocouple correctly fitted (2100 and 3100 series only) then this will 
display a signal in the “Temperature Sensor” box. 
  

4. Log Diagnostic Data:  Checking this box will allow the software to log the 
diagnostic data which can then be e-mailed to Sensotec for analysis.  Do not 
switch to a different tab while logging diagnostic data – the data is only 
logged while the “Diagnostics” tab is still selected.  The software will log 
diagnostic to a file named “Rapidox diagnostics file 210xxxx.txt” (where 
“xxxx” is the serial number of the analyser) in the folder shown in the 
yellow “Status” box at the bottom of the screen.  Data is logged every 6 

mailto:support@cambridge-sensotec.co.uk
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seconds, so the software should be left to run for at least 1 minute to gather 
a few data points.  In order to stop logging, simply uncheck the “Log 
Diagnostic Data” tick box.  Note that diagnostic data is always saved to the 
same file, and will automatically overwrite any existing file without 
prompting the user, so if you want to save existing data you must either 
rename it or copy (or move) it to a different folder, before checking the “Log 
Diagnostic Data” tick box again. If you are logging diagnostic data during 
the analyser’s warm up period, the “Acquisition data:” box will display the 
current sensor heating message, and will only display acquisition data once 
the oxygen sensor has reached its operating temperature. 
 
Once completed please e-mail this file to support@cambridge-
sensotec.co.uk for analysis. 

11. Troubleshooting 
 
Q: One of the channels says 'sensor heating' but won't begin measuring. 
A: Check to see if the particular sensor is getting hot.  If it is then make sure 

the cable plug is located firmly in the socket (2).  If you are still having 
problems contact Cambridge Sensotec for advice.  If the sensor stays cool 
then the internal heater has failed and the sensor needs replacing.  This 
problem can also occur if you are using helium gas without selecting the 
helium mode in the menu. 

 
Q: The Rapidox won't power up at all. 
A: There are fuses located on the power socket on both live and neutral lines.  

These are standard 20mm slow blow 3A fuses available from a supplier 
such as RS Components. 

 
Q: One or more of the sensors gives strange readings that are way off the 

expected values. 
A: Check to make sure which three calibration gases are selected.  Are they the 

same as the actual gases you used to perform the calibration?  If not you can 
change their values using the software.  Also check to see that the pressure 
sensor is working correctly and is measuring the same pressure as the 
oxygen sensor is being exposed to, if the pressure correction mode is set to 
‘Auto’. 

 
Q: The sensor does not read 20.9 - 21.0% in air (actual value is 20.95%). 
A: If the room air is very humid, it will slightly affect the observed 

measurement or the sensor may have drifted slightly because of natural 
ageing.  If you are using air as a calibration point then simply do a quick re-
calibration in the air to compensate for this. 

 
Q: I messed up the calibration procedure and the analyser is not working 

properly. 
A: Return the box to the factory defaults using the communications software, 

by selecting ‘Default Configuration’ followed by ‘Write Configuration to 
Analyser’ from the ‘File’ menu.  Now try re-calibrating the Rapidox. 

mailto:support@cambridge-sensotec.co.uk?subject=Rapidox%20Diagnostic%20data
mailto:support@cambridge-sensotec.co.uk?subject=Rapidox%20Diagnostic%20data
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Q: The date and time information on the RS232 is incorrect. 
A: The date, time and other features are user-programmable via the 

configuration software, or via the front panel using the built-in 
configuration menu.  If using the software, make sure that the time and date 
are correct on the PC you are using before attempting to reprogramme the 
Rapidox.  Also, the date format must be set via the software, and uses the 
setting from the PC that was last used to set the date and time.  The factory 
default date format is DD/MM/YY. 

 
Q: The software will not talk to the Rapidox. 
A: Make sure that you are using the correct cable and easy-sync unit as 

supplied as other cables will not work.  Make sure that your COM ports are 
recognised by your computer.  Check in your Windows device manager to 
see if there are any conflicts.  If you have an internal modem fixed to your 
PC you may experience difficulties using this software.  Contact Cambridge 
Sensotec for further advice. 
 

Q: I selected ‘Write Configuration to Analyser’ and now the Rapidox is way off 
calibration. 

A: Only select ‘Write Configuration to Analyser’ once all the values are 
correctly entered in the boxes on the right.  The best procedure is to ‘Read 
Analyser Configuration’ and then press ‘Copy’ so the values in the boxes are 
the same as those stored in the Rapidox memory.  You can then edit these 
values and then select ‘Write Configuration to Analyser’ when finished. 

 
Q: How do I get back to the factory calibration for my instrument. 
A:  Select ‘Load Configuration File’ from the ‘File’ menu and look for the 

“2100xxx.rxc”  file on your CD, where “2100xxx” is the serial number of 
your unit.  Select this file and then select ‘Write to the Analyser’.  This will 
load the factory calibration back into the Rapidox.  Alternatively you can 
use ‘Default Configuration’ on the ‘File’ menu which will automatically try 
to load “2100xxx.rxc”. 

 

12. Warranty 
 
The Rapidox analyser has been carefully tested and inspected before shipment 
and is guaranteed to be free from defective materials and workmanship for a 
period of twelve months from date of purchase and delivery.  The sensor head is 
replaceable and has a life expectancy in excess of 17,500 hours.  However, if the 
analysis gas contains corrosive gases or large quantities of particulates, sensor life 
may be shortened.  In the case of the latter, it is normally possible to insert a filter 
prior to the sensor head to remove the particulate material. 
 

12.1 Conditions of Warranty: 

 
1) This warranty is in addition to and does not affect any statutory rights of 
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consumer purchasers.  This warranty is valid worldwide on a “back to base basis”. 
 
2) This warranty covers breakdowns due to design or manufacturing faults; it does 
not apply to damage, however caused, wear and tear, neglect, unauthorised 
adjustment or repair, or any items of limited natural life. 
 
3) In the event of failure, please take the following action: 
 

a] Refer to the “Troubleshooting” section of your instruction manual to 
identify and possibly correct the problem. 
 
b] If the fault cannot be resolved, please contact the Cambridge Sensotec 
service and repair centre at the address given on the cover of the manual. 

 
4) The warranty period applicable shall be 12 months from the date of delivery 
provided that: 
 

a] Notice in writing of the defects complained of shall be given to Cambridge 
Sensotec (The Seller) upon their appearance, and 
 
b] such defects shall be found to have arisen from the Seller's faulty design, 
workmanship or materials, and 
  
c] The defective goods shall be returned to the Seller's premises at the 
Purchaser's expense if so requested by the Seller. 
 
d] Any repaired or replaced goods shall be redelivered by the Seller free of 
charge to the original point of delivery but otherwise in accordance with and 
subject to these Conditions of Sale. 

 
e] Alternatively the Seller shall be entitled at its absolute discretion to refund the 
price of the defective goods in the event that such price shall already have been 
paid by the Purchaser to the Seller, or, if such price has not been so paid, to 
relieve the Purchaser of all obligation to pay the same by the issue of a credit note 
in favour of the Purchaser in the amount of such price. 
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Rapidox CERTIFICATE of CALIBRATION 

 
 
Date:  ………………………. 
 
Rapidox Serial number:   ………………………………………. 

 

Calibration  Constant A   ………………………………………. 

 

Calibration Constant B   ………………………………………. 

 

Calibration Gas 1    ………………………………………. 

 

Calibration Gas 2    ………………………………………. 

 

Configuration Filename   ………………………………………. 

 

 

 

 

 
 
Calibrated by:    ………………………………………. 
 
 
 

Signed: …………………………………………….. 
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